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1. Open Data into ioGAS™
ioGAS™ supports the following file types: 

l ioGAS™ (.gas files)

l Tab-delimited text (.txt files)

l Comma-delimited text (.csv files)

l Excel (.xls, .xlsx files)

l XRF (REFLEX & Olympus .csv & Niton .ntg files)

l MapInfo GIS (.tab files)

l External databases:

l IMDEXHUB-IQ

l acQuire GIM Suite

l MS Access

l SQL Server

l ALS Webtrieve

l Live links: (purchased separately)

l Leapfrog Geo

l GOCAD Mining Suite

l Geoscience ANALYST

Open Excel File

1. Click the Open button on the File ribbon, or any other functional ribbon (other
than Help).

2. Browse to one of the following locations depending on the installed operating sys-
tem:

l Windows (64-bit): C:\Program Files\ioAnalytics\ioGAS™-64.Ver-
sion\demodata folder

l Mac installation: ioGAS™ Applic-
ation\Contents\Resources\app\demodata folder

3. Use the drop-down arrow next to Files of type: and select Excel Spreadsheet files
- all (.xls, .xlsx files).

4. Highlight the demo.xlsx file and click on the Open File button.



© Imdex Limited 2019 - 6 - RTI-MAN-0360 V2

Alternatively drag and drop the file from Windows Explorer directly into ioGAS™, or copy

data open in Excel into the system clipboard and use the File> Open from
Clipboard ribbon option.
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2. Define Column Types
Generally when a dataset is first imported into ioGAS™ the Column Properties dialog is
displayed. This is where columns in the dataset are matched to columns required by
ioGAS™ in order for data to be plotted successfully.

Special Columns
This section is where the sample number and coordinate columns in the dataset are
selected so they can used to display data in the plot windows. ioGAS™ will use the
column names in the dataset to automatically assign the special columns. The
columns can be manually changed to the correct ones or left blank if the dataset does
not contain any matching columns.

l ID - Unique sample identifier.

l East/North - X and Y coordinate columns. Used to display data in all spatial map
views. Generally these will be in a projected coordinate system such as UTM
coordinates.
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l East/North Projection - Coordinate system used for East/North columns above.
This is the projection that is used in the geographical file exports, e.g. gridded
images as GeoTiff Images or ER Mapper grids, ArcGIS and MapInfo exports

l Elevation - Z value column. Required to display data in 3D Attribute Maps.

l WGS84 Longitude/Latitude (decimal degrees) - Separate X and Y lat/long
coordinate columns in WGS84 decimal degrees required in order to export data to
Google Earth.

l Date/Time - ioGAS™ recognises time/date data in Excel or ISO8601 format.
Assign a date/time column here to ensure data is displayed correctly in the Data
View window, the Line Plot tool and tooltip labels. Note that ioGAS™ does not
support timezones.

1. Match the columns in the demo dataset to the following Special Columns in
ioGAS™:

l ID = Sample Num

l East = East_AMG84_z51

l North = North_AMG84_z51

l East/North projection = AMG (AGD84) Zone 51

l WGS84 Longitude (decimal degrees) = Long_WGS84

l WGS84 latitude (decimal degrees) = Lat_WGS84

Column Name and Type
In the Column Name and Type area ioGAS™ automatically assigns each column in the
dataset as Numeric or Text . Analysis data to be used in plots is generally numeric
whereas text data is used to 'group' data, for example Regolith Unit, Geology, Sample
Medium, etc. If a column is imported as a text field yet contains numeric data then the
column can be re-assigned as a numeric column and vice versa.

In some cases it may be useful to assign columns as Non-plot. Examples of non-plot
columns may include Sample ID or coordinate columns that will not be used in plot
generation or data analysis.

2. Scroll down and have a look at the different column types assigned to this data-
set.

Text columns are denoted by a black circle and non-plot columns with a grey
circle. Numeric columns can have either a blue circle or a green circle next to them
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depending on whether they are "aliased" or not. See Step 4 for more information
on aliasing variables. Red circles denote that there is a problem such as duplicate
column names and will need to be fixed before exiting this dialog.

ioGAS™ lists the number of samples in each column that are numeric, text or null
(blank) on the right-hand side of the dialog. At the bottom of the dialog is the
number of rows (999) and columns (41).

3. Place the cursor over the original column name (without mouse clicking) to view
tooltip information about the data in the selected column. Text columns display
the individual categories and numeric columns display min, median and max val-
ues. If the tooltips do not appear, click within the Column Properties dialog to
make it active and try again.

It is possible to plot data and use many of the functions within
ioGAS™ without having an ID column or coordinate columns
selected.

It is also possible to remove any columns before import by clicking on the cross next to
the column to delete. These columns will be permanently removed from the imported
dataset when the OK button is selected.
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3. Set Column Alias Names
One very important feature of ioGAS™ is that if the element and the units that the
values are captured in is known for each column, ioGAS™ can perform unit or
element/oxide conversions on-the-fly in order to use the data with the classification
diagrams, calculations and spider plot normalisations shipped with the program if the
data is not already in the required format.

If ioGAS™ can already guess the "aliased" name from the original column name it will
attempt to automatically assign an "aliased" name when the file is imported. E.g. Au_
ppb



© Imdex Limited 2019 - 11 - RTI-MAN-0360 V2

Alias Columns
Use the following steps to "alias" the columns in the demonstration dataset to
standard element/unit names:

1. Click on the Guess Aliases button. ioGAS™ automatically
guesses the element and unit from the original column name for all columns. To

alias a single column at a time use the Guess Alias button next to each vari-
able.

2. It is important to check to make sure that the correct element/oxide/unit com-
bination name is applied.

To manually assign an alias name to a column select the appropriate
element/oxide/unit combination from the Alias pull-down list. To reset a single

column back to the original name click on the Reset Alias button next to

each column or reset them all using the Reset Aliases button.

3. Observe the original names in the demonstration dataset compared with their
"aliased" names. The blue circles next to each variable are now coloured green to
indicate the variables are "aliased".

In ioGAS™ all variables can be renamed as desired with the new name
used everywhere in the program. To enter a new name for a column simply
overwrite the one displayed in the Alias column for that variable.

4. When you are satisfied that the columns are "aliased" correctly click OK to pro-
ceed.

The Column Properties settings are retained when the file is saved in ioGAS™ format

and can be modified at any time by clicking on Column Properties in the Data

ribbon or from the Data drop-down menu on all ribbons (except File & Help).
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4. User Interface & Attribute Map
The demo dataset is now loaded into ioGAS™ with the file name and path displayed in
the title bar of the program. 

The ioGAS™ user interface is comprised of a number of components:

Title bar

The Title Bar displays the ioGAS™ version, build and the file name and file path of the
currently open dataset.

Ribbon Toolbar

The tabs along the menu bar at the top of the screen open a corresponding ribbon
toolbar where features are grouped into bands of related functionality. Frequently used
functions are laid out as large icons, many with related functions in drop-down menus.
Less frequently used functions are laid out as small icons.

If this is the first dataset loaded into ioGAS™ for this work session then the Home
ribbon toolbar should be currently displayed. If not, click on the Home tab to display
this ribbon.
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Quick Access Toolbar

On the right side of the menu bar is the Quick Access Toolbar containing tools that are
relevant in any context: show/hide ribbon, favourite tools list, open windows list,
display attribute legend and help.

Attribute Manager

The Attribute Manager controls the way each data point is "attributed" when it is
displayed in a plot window with respect to colour, shape, size and visibility. The
Attribute Manager can also be used to set a filter on the dataset in order to create a
subset of data.

Status Bar

Displays information about toolbar icons along with other important warning and error
messages when processes are run to let users know if there are any problems, e.g. when
data cannot be logged due to 0's or negative values, missing variable data when
displaying mineral nodes, etc. Warning messages are displayed in red.

Progress Bar

Some processes can take a while to complete. This orange bar can be used as a visual
aid to view progress.

Memory Meter

The Memory Meter shows the actual memory being used by ioGAS™, as a fraction of
available memory. The meter is intended as a guide to help the user decide when to
close windows as the memory gets close to its limits.

Attribute Map
An Attribute Map is a pseudo-map or geographical view of a dataset that plots the X
coordinates against the Y coordinates. It is used to view a dataset in a spatial context
and is one of the main plot types used with Google Earth and GIS programs such as
ArcGIS or MapInfo.

1. Click on Attribute Map on the Home ribbon.
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Context Toolbar
When the Attribute Map is open, a number of buttons are displayed vertically on the
right-hand side of the screen. This is the Attribute Map context toolbar and contains
tools relating to this plot window. To make the context toolbar active click in the plot
window or on the window title bar. Place the cursor over each toolbar button to view
information about each tool in a tooltip.

To move the Attribute Map window click on the window title bar and drag to a new
location while holding down the left-mouse button. Plots and other windows open in
ioGAS™ can be re-sized by placing the cursor over one of the edges of the window and

then dragging it in or out. Minimise, Restore and Close buttons are also
available in the top right hand corner of each open window.
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5. Select Variables 
Before any data can be displayed in a plot window (aside from an Attribute Map if
coordinates are present) the variable columns must be selected for use. The current
variable selection is generally shown in the main window title after the file name, which
in this case is empty as there are no variables selected yet.

Notice that a number of icons are greyed out on the ribbon. This also indicates that
either no variables are selected for use or that not enough variables are selected to
display that particular plot, e.g. a ternary plot requires three variables to be selected
before the icon is active.

The Select Variables tool is located on the Tools band of the Home ribbon along with
other commonly used tools such as the Attribute Manager, Data and Pause Updates
which will be discussed later in this tutorial. This suite of tools is also available on the
Common Band on most of the other ribbon toolbars.

1. Click on Select Variables on the Home ribbon to display the Select Variables
dialog.

2. Add the following variables to the Selected window: Zn_ppm, Ni_ppm, Fe2O3_pct
and Cu_ppm.

To select an individual variable double-click on the entry in the Available window
to move it across to the Selected window or use the arrows in the middle of the
dialog. Multiple selections can be made using the Ctrl/Shift keys.
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Observe that the colour of the variable columns match the colours used in the
Column Properties dialog. All of the selected variables are green as they are
numeric columns that have been "aliased" to the standard ioGAS™ element/unit
names. The black variables are text fields and can be selected for use with plots if
they will produce meaningful results. Numeric variables which have not been
aliased will appear in blue.

To sort the order of the variables alphabetically in the Available window use the
right-mouse button. The variables are sorted within each "type", e.g. text, numeric,
aliased, etc. Click again to return to file order.

The order of the variables in the Selected window can be modified using the Up
and Down arrows or by dragging to a new location with the mouse cursor. For
some plots such as XY Scatterplots the first variable is used as the X axis when
there are multiple variables to be plotted. Ternary plots use only the first three
variables in the Selected window so re-ordering is often required to ensure the
correct variables are displayed.

Once you are more familiar with the software there are a couple of ways to select
multiple variables at a time rather than having to select them each time:
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Provided
Drop-down list containing groups of commonly used elements provided by
ioGAS™. Individual variables can be added or removed from these
selections. Provided groups include:

l Element Groups - Majors , Immobile, REE, PGM

l Deposit Style - Porphyry Cu-Au, Epithermal/Meso-
thermal/Orogenic/Laterite Au, IOCG, MVT, VHMS, plus
many more.

l Secondary Scavenging - Fe and Mn Oxides

l Goldschmidt - Chalcophile, Lithophile, Siderophile

History
Each variable selection is saved and is available to be selected for use again
within the current dataset from the History pull-down list.

3. Click OK to exit the dialog.

Now that a number of variables are selected for use all of the tools on the Home ribbon
are now active. The current variable selection is also displayed in the ioGAS™ title bar
after the open file name.
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6. Validate Data 

1. Click on the Data tab to open the Data ribbon and have a look at the options in
the Validate and Edit bands. These include:

Data Doctor

The Data Doctor tool displays the number of null, 0, -, > and < records for
each of the selected variables. Using this tool It is possible to replace below
detection limit values with a ½ positive value or custom value and above
detection values with a custom value. Colour attribute any of these samples
in open plot windows to see where they are located. Any changes made to
the data are recorded in a log file for future reference.

Search and Replace

Replace text or numeric entries in selected columns or the entire dataset. All
modifications are reported in the change log file.

l Convert Zeros to Nulls (Coordinate Columns) (under Search and
Replace drop-down menu) - Replace zero entries in coordinate columns
with null values to prevent them from plotting at 0,0 in map views.

2. Click on Data Doctor.
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The Zn_ppm and Cu_ppm columns contain some below detection limit data. The
validation type, the value, the number of samples with this value and the % of
affected valid data is displayed along with a recommended replacement value
which in this case is 1 (the half positive value of the below detection limit, i.e. -2).

3. Check the Replace Value box next to each entry and then click Apply.

As the replacements are made the updated Data Doctor reports that there are
now no data validation problems with the dataset.

4. Click on the Show Log button at the bottom. In the Change Log window scroll to
the right to view the number of Zn_ppm and Cu_ppm occurrences that have been
updated with the new replacement value.

The Change Log file lists all changes to a dataset from when it is first imported
into ioGAS™ and records all data validation replacements, columns removed and
rows deleted. The Change Log can be accessed at any time using the Data>Show
Change Log ribbon option.

5. Select Close to exit this window and then Close to exit the Data Doctor window.
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7. Display Data in Tabular View
The View Data tool displays the dataset in a spreadsheet or tabular view as
rows/columns.

1. Select Data from the Tools band of the Home ribbon. This will display all the
columns in the dataset regardless of what variables are selected.

2. Use the scroll-bars to scroll up and down and left and right to get a feel for the
columns in the dataset. Observe the colour, shape, size and visible columns on
the left-hand side. These columns show the current attributes that are applied to
each data row. These are currently set to the default attributes which are a black
circle, 6 pt in size.

3. Sort a variable column in ascending order by left-mouse clicking once in the
column header. Click again in the header to reverse the sort. The [Order] column is
automatically generated when the data is imported and can be used to sort the
data back to its original import order at any time.

4. It is possible to click on rows in this view and apply colour/shape/size attributes
to the selection using the Apply Attributes to Selection button. This will be
covered later in this tutorial. Data can also be copied into other programs using
the two Copy buttons at the bottom of the dialog.

5. Close the Data window using the X in the top right hand corner.
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8. Navigation Tools and Labels
1. Go back to the Attribute Map window that was opened earlier.

To re-open this plot select Attribute Map from the Home ribbon. The context
toolbar is displayed on the right-hand side of the screen. Maximise the window to
make it easier to see.

On the Attribute Map toolbar are a number of standard tools available to navigate
within a plot window.

Zooming and Panning
2. To zoom in on an area click on Zoom to Box and drag a box in the window over

some data points using the left mouse button. The window contents are zoomed
to the extents of this box. Alternatively, place the cursor in the plot window and
use the scroll bar on your mouse to zoom in and out at the cursor location.

3. Select Pan and click and drag the left-mouse button in the plot window to pan
the view.

4. Right-mouse click in the plot window and select Zoom Previous from the pop-up
menu. To restore the data to the original extents right-mouse click again and
select Zoom to Data.
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5. You can also use the Dynamic Zoom tool to zoom in and out by holding down
the left-mouse button in the plot window and then dragging it up to zoom out or
down to zoom in. The scroll bar on the mouse can also be used to zoom in and
out if available. Restore the plot view when you are finished.

View Data Tooltips and Labels

Place the cursor over a data point in the plot window (without clicking) until a
tooltip information box is displayed. The information displayed in this box
includes the ID, East and North coordinates, any colour/shape/size attribute
groups which are assigned and any data columns selected to be displayed as
labels. e.g. Regolith and Geology units to which the sample belongs.

If the tooltip is not displaying, click in the title bar of the Attribute Map
window to make it active and then try again.

6. Click on Select Labels on the Data ribbon. This is where it is possible to
choose which other columns will display in the tooltip information box.
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7. Select the Sample Num, Regolith and Geology columns and a couple of other vari-
ables and move them into the Selected window. Click OK to exit the dialog.

8. Click back in the Attribute Map window to make it active and place the cursor
over a sample. The new label columns are now displayed.

9. To display the Sample Num as label in the attribute map window select Ren-
dering Settings on the toolbar and check the Show item labels box. Click Apply to
view the labels in the plot window. Zoom in to display more labels.

Attribute Maps can also be created from the Map ribbon.
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9. Open Multiple Plot Windows
Now it is time to open some of the other plots available in ioGAS™ and look at the
different ways that they can be displayed.

Scatterplots

1. Select XY Plot from the Plots band of the Home ribbon.

See that only three XY plots are created. This is because although four variables
are selected: Zn_ppm, Ni_ppm, Fe2O3_pct and Cu_ppm, the first variable Zn_ppm
is used as the X axis and the other variables as the Y axis.

2. With the XY Plot window as the active window, select Log X Axis and Log Y
Axis from the XY toolbar to change the X and Y axes from raw data values to log
scale.

3. Click on each of the or buttons to change each of the X and Y axes to a
Power Transformed axis. ioGAS™ uses a Lambda power transformation method
to de-skew data so it more closely approximates a normal distribution. Click on
these buttons again to return to linear axes.

Probability Plots

4. Select Probability Plot from the Plots band of the Home ribbon.

Each variable is displayed as an individual probability plot in a single window.
Observe that the Probability toolbar contains similar zoom, pan and log/power
transform options as the XY toolbar.

5. Click on to display probability values along the X axis instead of N-Score (std
dev) values.

6. To change the view to a cumulative frequency plot distribution click on the but-
ton. To return to normal probability right-mouse click on the button and select
Normal.

Histograms
7. To display individual plots in a tabbed window go to the Window band, click on

the arrow under Settings and choose Tabbed windows from the drop-down
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menu. A circle is placed next to this menu entry to show this window mode is
selected.

8. Select Histogram from the Plots band.

Observe that each of the variable histograms is displayed in a separate tab in the
same plot window instead of all in the same plot window like the XY and
probability plots. Click on the tabs to view each histogram.

9. The histograms show the number of samples in each binning range. Use the

and arrows on the Histogram toolbar to increase or decrease the number of
bins.

Arrange Windows
There should now be four plot windows open in ioGAS™ but they are most likely all
displaying on top of each other.

10. To arrange multiple windows click Cascade on the Window band to view all
the windows with their title bars visible.

11. Now select Tile to view all the plot windows without overlapping.
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12. Click on Save Checkpoint in the Save band on the Home ribbon. Enter a name
for the checkpoint such asMultiple Plot Windows and click OK.

A checkpoint saves the currently open plot windows and settings and can be
restored at a later point in time.

13. Go back to Settings and choose Normal windows from the drop-down menu
to return to the default window display. The selected window mode will apply to
new windows only, not those already open.

XY, Probability Plots and Histograms can also be created from the Graph
ribbon.
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10. Apply Colour/Shape/Size Attributes
Now that there are some plot windows created, this next section looks at how to
change the colour, shape and size attributes for individual data points, apply them to
data selections and turn the visibility of data points on and off. This is all controlled by
the Attribute Manager.

1. Select Attribute Manager from the Tools band on the Home ribbon. The Ctrl-
A keyboard shortcut can also be used to open the Attribute Manager window.

The Attribute Manager contains three main tabs, one each for colour, shape and
size. This means that for every data point the values for up to three variables can
be displayed simultaneously, one for each attribute. By default, all of the samples
in the dataset will be attributed unless a subset of data is selected for use in the
Filter tab. When a Filter is set only the filtered data samples will be attributed.

Auto-Attribute Text Data
Auto-Attributing can be used to apply attributes to data based on unique values in a
text column.

2. With the Colour tab active, select Regolith Unit from the drop-down list and click
on the Auto-Attribute button.
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The data is now coloured by Regolith Unit in every plot window. The number of
data points in each colour group is displayed along with how many of the points
are currently visible.

3. Click on the Shape tab this time. Select Geology from the column pull-down list.
Click on the Auto-Attribute button.

The data points are now coloured by regolith unit with the shape representing the
underlying geological unit.
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Show Legend
The legend window is another way of displaying the current Attribute Manager settings.

4. Click on Legend on the Window band of the Home ribbon to open up a
separate Legend window. The legend window can also be opened up from the
icon on the Quick Access toolbar or by the Ctrl-L keyboard shortcut.

5. To view the attributes in a combined legend, right-mouse click within the legend
window and choose Legend Mode - Combined/Separate. Click this option again
to return the default legend view.
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Change Visibility
In the Attribute Manager it is possible to sub-set the data so that only data points from
particular regolith units are displayed. This is controlled by the visibility options.
6. In the Colour tab, uncheck the box in the Visible column next to the D9 and DA

regolith groups. The rows visible column is set to 0 for these groups.
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Observe how the data points are removed from all open plot windows.
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7. Click on Save Checkpoint in the Save band on the Home ribbon. Enter a name
for the checkpoint such as DC + E Regolith Units and click OK.

8. Check the boxes to re-display the samples or click on the All Visible button at the
bottom of the Attribute Manager window.

Auto-Attribute Numeric Data
Auto- Attributing can be used to apply attributes to data based on data
percentiles/custom ranges for numeric columns. For numeric data columns, data
points are attributed according to a selected percentile binning range, e.g. 5 or 10 equal
ranges, Quartile, Progressive, etc and then coloured using one of the supplied colour
ramps. It is also possible to create custom bin ranges rather than percentiles which can
be applied to different datasets.
9. While still in the Colour tab select a numeric variable column such as Cu_ppm

from the column pull-down list.

10. Click on the down arrow next to 10 Equal Ranges and select Progressive from the
binning range pull-down list. The Progressive binning range divides the data into
percentiles based on 30, 60, 80, 90, 95 and 98% cut-offs.

11. Click on the arrow next to the colour ramp and look at the available options. Use
the default ioGeochem Non-linear colour ramp at the top of the list.

12. Click Auto-Attribute to apply the colours and select YES to overwrite the existing
colour attributes.
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13. Observe how the values are updated in the Legend.

14. To change the assigned colour/shape/size of an attribute double-click on the
attribute (e.g. red circle, square, etc) and select a different one from the colour
palette or drop-down list (for shape/size).
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15. Attributes can be combined by dragging one group onto another group, e.g. drag
the Geology group PMo onto PM to create a combined group named PM + PMo.

16. It is also possible to change the name of an attribute by double-clicking in the
Name column and overwriting the entry with a new one. Any changes are dis-
played in the Legend window but are not written back to the dataset.

Remove Attributes
17. Highlight the PEw entry in the Shape tab. To remove this entry from the list use

the button. All of the PEw samples now show the Default
Shape.

18. To remove all the Shape attribute entries click on the button.
All samples now show the Default Shape.

19. To remove all the currently applied colour/shape and size attributes click on the

button.
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Attribute Filter
The Attribute Manager Filter is a way to create a subset of data to work with in ioGAS™
without having to open up a new file. Applying a data filter enables only data points
that fit the filter criteria to be displayed in any open plot windows.
20. In the Attribute Manager click on the Filter tab.

21. Choose Sample Medium from the drop-down list and click the Auto-Attribute but-
ton.

22. Turn off the visibility for all of the groups, leaving only the 397 SHTW samples.

23. Click on Save Checkpoint in the Save band on the Home ribbon. Enter a name
for the checkpoint such as SHTW Samples and click OK.

24. Experiment with Auto-Attributing data using different text columns and also with
numeric columns using different colour ramp/binning combinations.

Observe how the colour, shape and size attributes are only applied to the filtered
SHTW samples.

25. Filter attribute entries can be removed by clicking on the or

buttons. Note that if any filter is active (i.e. some rows are
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excluded from the dataset using a filter), the icon on the Filter tab will be red
instead of blue.

It is possible to attribute data by applying the same variable to the colour,
shape and size attribute tab or apply three different variables.

Attribute Manager Window
The Attribute Manager window can be dragged outside of the application if dual
screens are setup to keep the Attribute Manager window open all the time.

Alternatively, select External Windows Always on Top from the Settings drop-down
menu to keep the Attribute Manager displayed on top of other plot windows instead of
minimising.
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11. Make Data Selections
The Attribute Manager can also be used to assign colours, symbols or different sizes to
manually selected data points in a plot window.

1. Select Attribute Manager from the Tools band on the Home ribbon or use the
Ctrl-A keyboard shortcut.

2. Remove any existing filters and/or attributes using the and

buttons.

3. Select the Colour tab and click on the Add an Attribute button.
A new colour row is added under the default colour row and is coloured red.

4. Double-click on the New Colour entry to assign a name for the attribute (ie. High
Cu) and then click Enter. Make sure that the High Cu row is highlighted (in blue)
and that a red circle with "High Cu" is also displayed in the top right of the Attrib-
ute Manager window.

5. Select the Shape tab and click on the Add an Attribute button. Change the shape
to a triangle. Select the row so it is highlighted in blue.

6. Repeat the process in the Size tab by making a new entry with a size of 10 and
selecting this row.

The shape and size attributes should display in the top right corner as New Shape
and New Sizewhen they are highlighted correctly.
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7. Click in the Probability Plot window created back in Step 9.

Otherwise, click on the Probability Plot on the Home ribbon again if the plot
window has been closed. Re-size this window to make it bigger and make sure the
Probability toolbar is visible by clicking in the plot window to make it active.

8. Select Attribute Polygon from the toolbar.

9. In the Cu_ppm probability plot window, hold down the left mouse button and click
around the high values in the plot window to create a polygon (region) object.
Double-click to finish.

All of the data points within the polygon should now be attributed with a red
triangle 10 pt in size.
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10. Select Tile from the Window band to view all the open plot windows. Observe
the red triangle attributed points in the other plot windows. The Legend window is
also updated.

11. Leaving the High Cu samples attributed, repeat the process outlined above to
make another selection on the probability plot using a blue square 10 pt com-
bination. Assign a name for the new group in the colour tab.

Make sure that blue colour, square shape and Size 10 pt attributes are highlighted
in their respective tabs and displayed in the Attribute Manager top right corner
prior to making the data selection.

12. Drag the Probability Plot window to make it bigger and then zoom in on the Cu_
ppm probability plot to show the samples with values below the red triangles.
Using the Attribute Point tool click on individual points to attribute them as
blue squares. Observe how the samples are updating in the other probability plot
windows.

12. Select Data and left-mouse click in the [Colour] column header cell twice to
display the data in descending order based on colour. Observe how the colour,
shape and size attributes have been updated next to each row.
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13. Click on Save Checkpoint in the Save band on the Home ribbon. Enter a name
for the checkpoint such as High Cu samples and click OK.

14. Open the Attribute Manager again if it has closed (Ctrl-A) and remove all

attributes using the Global button. Experiment with creating
different colour, shape and size attribute combinations and applying them to
data selections. View the results in the data table.

15. Close all plots at the completion of this exercise using Close All on the Win-
dow band or use the Ctrl-Shift-W keyboard shortcut.
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12. Univariate Statistics
When analysing data it is useful to look at various statistical parameters for either the
entire dataset or for selected categories within a dataset. The selected categories are
based on the colour groups as set in the Attribute Manager.

Summary Statistics

1. Open an Attribute Map from the Home ribbon.

2. Open the Attribute Manager using the button or Ctrl-A and remove any exist-
ing attributes. Click on the Colour tab and auto-attribute the data using the Rego-
lith unit column.

3. Select Summary Stats from the Stats band on the Home ribbon.
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In the Summary Statistics window all of the selected variables are displayed
along with a number of basic statistics for each regolith group. The values in each
group are also coloured according the colours in the Attribute Manager.
The values at the top in black are the calculated statistics for all visible data
regardless of colour group as denoted in the Attribute Manager.

5. To change the displayed statistics click on Choose Statistics on the Summary
Statistics toolbar. Check or uncheck the statistics as required and click Apply to
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update.

6. Click on Change Grouping on the toolbar to group the data by statistic rather
than by group.

7. Close the Statistics window using the X in the top left hand corner when
complete.

Frequency Table
View all the unique values for each selected variable and the counts for each using a
Frequency Table.

1. Select Display Frequency Table from the Summary Stats drop-down menu on
the Home ribbon.

2. Each variable is displayed in a separate tab.

Correlation Matrix
Display the correlation coefficient values for each paired combination of selected
variables.

1. Select Correlation Matrix from the Analysis ribbon.
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Highly positive or negative correlated pairs of data are coloured in pink and red.
The first tab shows the correlation values for all of the visible data selected in the
Attribute Manager. The other tabs show the correlation values for each colour
attribute group.

Summary statistics and Frequency Table can also be accessed via the
Analysis ribbon.
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13. Variable Maps and Gridding
Variable maps and gridding are ioGAS™ Map tools, in addition to Attribute Maps. The
data in these plots is displayed spatially and can be exported for use in GIS
applications.

Variable Maps
A Variable Map displays each of the selected variables in a separate map view. The
data points in each map are displayed using one of the pre-defined thematic operation,
colour and size ramping options. Variable maps are good for comparing high or low
concentrations across multiple elements.

1. Select Settings>Normal Windows from the Window band if it is not already
selected.

2. Select Variable Map from the Home ribbon.

3. By default the data for each variable is displayed according to its ranked per-
centile. To view what data values are represented by their colour and size attrib-
utes click on Show/hide colour bar legend on the variable map toolbar.

4. Click on Save Checkpoint in the Save band on the Home ribbon. Enter a name
for the checkpoint such as Ranked Variable Maps and click OK.

5. To modify the thematic settings click on Change thematic settings on the vari-
able map toolbar.
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In addition to the ranked thematic operation, all of the other available binning
ranges in the Attribute Manager can also be used in the variable maps, for
example, quartile, progressive half, equal tails 6 groups, etc. Custom bin ranges
can also be selected here.

6. Experiment by selecting other thematic operations and observing the legend and
data points automatically updating.

7. Select from a number of different Colour and Size ramps and observe how the
data appearance changes. To see what type of size ramp is being applied place
the cursor over the entry in the pull-down list. Repeat for the colour ramps.

With the exception of the ranked thematic operation, all other binning ranges can
be coloured using continuous colour ramps or discrete colours.

8. Close all variable map windows upon completion of this exercise.

Export Variable Maps
Variable maps can be exported and viewed in Google Earth and MapInfo.

Gridding
A grid is created from the interpolation of located data onto a regular grid or matrix
that is then rendered so that it can be viewed as a continuous coloured or shaded
surface. ioGAS™ includes a gridding tool that uses a modified Inverse Distance
Weighting algorithm to generate the interpolated grid cell values.
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Only one grid window can be displayed in ioGAS™ at a time.

1. Select Grid from the Home ribbon.

2. TheMake Grids dialog is displayed.
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ioGAS™ attempts to automatically select the appropriate grid cell size settings for
the dataset based on an algorithm that analyses the spatial structure of the data.
All of the other gridding parameters including grid cell size, search radius,
smoothing, etc. can be customised.

3. Leave the default settings and click OK. The grids are displayed in a single plot
window.

4. To view the grid cell values that the colours represent click on Show/hide grid
legend on the gridding toolbar.

5. Overlay the attribute points on top of the grid using Show/hide attribute map.

6. Place the cursor over the grid and use the zoom tools (or mouse scroll bar) to
zoom all the grids together at the cursor location.

7. To change the grid parameters select Display grid options from the toolbar.

8. Close the grid window upon completion of this exercise.

Export Grids
The gridded images can be exported using the GeoTiff and ER Mapper Grid export
options on the gridding toolbar.

Variable Maps and Grids can also be accessed via the Map ribbon.
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14. Diagrams, Spiders & Calculations
ioGAS™ contains a number of standard classification diagrams arranged into a logical
menu system. Data can be plotted on classification diagrams and then attributed
according to the classification group in which they are located. These attributes can be
written back to the file and used in further analysis or exported for use in third-party
programs.

In order to view data on a supplied classification diagram the variable columns must be
"aliased" in the Column Properties dialog as outlined in Step 3. This is so ioGAS™ can
perform any element/oxide/unit conversions to get the data into the correct format to
display on the diagram.

The diagrams are located under Provided on the Diagram ribbon and are arranged
into a series of sub-menus:

To view the diagram supporting information from within the Diagram>Provided menu
hover the cursor over the menu item. If a diagram is greyed out then it means that one
or more variables is not present in the dataset. The missing variable(s) are displayed in
the tooltip when the cursor is hovered over the entry.



© Imdex Limited 2019 - 51 - RTI-MAN-0360 V2

This exercise displays the demonstration dataset on a Regolith diagram that plots K/Al
vs Mg/Al wt values to classify regolith data into transported clays, saprolite and
younger alluvium/colluvium.

1. In Provided, navigate to Regolith>Classification and select the Regolith Frac-
tionation (McQueen, 2006) diagram.

The data are plotted with the current attributes onto the diagram in a new plot
window. The diagram window contains zooming, panning and selection tools the
same as found on other plot toolbars.

2. Zoom out to see that not all the data plots within the diagram extents.

3. Right-mouse click and select Zoom to Diagram from the pop-up menu to return to
the original diagram view.
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4. To attribute the data points with the regolith classification group colours select
Colour Rows from Polygon on the diagram toolbar and select "YES" to over-

write existing colour attributes.

5. Open the Attribute Manager to view the new colour groups based on the diagram
classifications. Any samples that fall outside the diagram boundaries are col-
oured using the default colour black.

6. To make a new variable column which contains the regolith classification group
for each row select From Colour from the Make Variables band on the Data rib-
bon.

7. Leave the default column name and click OK.

8. Open up a tabular view of the data using Data and scroll to the right to see
the newly added columns.

One column is text with the rock classification based on the polygon name; the
other column is numeric with a different number for each rock classification.
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It is possible to make and edit your own classification diagrams and share
them with others within your organisation.

Other Provided Resources
Aside from classification diagrams, ioGAS™ also provides a library of commonly used
spider normalisations and calculations under the Calculation and Spider ribbons
respectively.
Spider Plots
1. Click on the Spider tab to open the ribbon toolbar.

2. In Provided, navigate to Crust and select the Av Abundance Earth Crust
spider.

3. Use Make variables from spider on the Spider toolbar to add normalised val-
ues for each element to the dataset as new columns.

4. Open up a tabular view of the data using Data and scroll to the right to see
the newly added normalisation columns.
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Calculations
1. Click on the Calculation tab to open the ribbon toolbar.

2. In Provided, navigate to Regolith and select the Chemical Index of Alteration
(CIA) calculation.

3. Open up a tabular view of the data using Data and scroll to the right to see
the newly added CIA column.

Create Custom Diagrams, Spiders and Calculations
In addition to the provided resources, users can create their own classification
diagrams, spider normalisations and calculations.
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15. Checkpoints and Templates

Save and Restore Checkpoints
During this tutorial we have been saving a number of checkpoints. A Checkpoint is a
saved snapshot of an ioGAS™ work session taken at a particular point in time and
contains information about all of the open plot windows plus any other plot settings
including the colour, shape, size, filter and visibility attributes displayed when the
checkpoint was created.

Multiple checkpoints can be created and stored in a list for easy retrieval. At a later
point in time a checkpoint can be selected from the list and the saved plot windows
and attributes restored as the current work session, replacing the existing ioGAS™
display. Checkpoints are saved with the ioGAS™ file.

1. To restore a checkpoint select Open Checkpoint on the Open band of the File

or Home ribbon. (This function is also available from the Open drop-down
menu on other functional ribbons.)

2. All of the saved checkpoints appear in a drop-down list in creation order (newest
on top):

3. Select Multiple Plots from the list and Restore.

Observe how the current ioGAS™ session is replaced with the saved checkpoint
windows and the saved attributes are also restored.

4. Restore the other saved checkpoints.

Checkpoints can be renamed or deleted. To remove all checkpoints select Clear All
Checkpoints.

Templates
Templates enable groups of plots and customised settings to be saved and then
restored with updated or new datasets. Templates can be created that represent
standard workflows in your data analysis and can be shared with colleagues.



© Imdex Limited 2019 - 56 - RTI-MAN-0360 V2

Templates work with aliased data so that if the exact element/oxide/unit used in the
template is not present in the dataset but the element is available in another form,
ioGAS™ can convert the data on-the-fly to the required combination.

A number of commonly used plot combinations have been created for you and are
available in ioGAS™.

1. Go to Provided in the Open Templates band in the File ribbon or alternatively

from the Open drop-down menu on any of the functional bands (Home, Data,
Calculation, Analysis, etc.).

2. Select the Alteration Plots template. Hover the cursor over the template entry to
view the contents.

3. In the Choose dialog select Template. This will use the stored plot axis ranges in
the template when opening up the plot windows. The Default option will re-scale
the axis ranges using the current dataset.

Templates do not replace the currently open plot windows so multiple
templates can be open at the same time.

4. Use Close All on the Window band of the Home ribbon to close all windows.

Create Custom Templates
In addition to the provided resources, users can create their own templates.
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16. Save, Copy, Export and Print Options

Save ioGAS™ File

1. Click Save from any of the ribbons (other than Help).

2. Enter a name for the file and save to your desktop.

The Save option saves both the current data and the attribute information as a
native ioGAS™ file. Any open plot windows are also saved and will be re-opened

when the file is next loaded. To re-open a native ioGAS™ file use the Open
menu option.

Save As ioGAS™ File

To save a copy of an ioGAS™ file select Save As from the Save drop-down
menu and choose ioGAS™ File from the Files of Type pull-down list.

Copy Options
Before copying a plot window as an image or vector file you may want to modify some
of the plot parameters such as plot title, axis ranges, label colours, etc. These
parameters can be changed by one of two ways:

l Plot Settings - Affects individual plots only and includes options to show/hide
plot title, change title text, show/hide axis labels, change axis label text and
modify axis ranges. Right-mouse on an individual plot and choose plot settings
from the pop-up menu.
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l Plot Window Style Settings - Affects all plots in a window and includes options to
change title and axis label font, colour and size, show/hide tick marks and labels,
tick label font, colour and size and show/hide gridlines. Click on Plot Window
Style Settings on selected toolbars to access this dialog:
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Copy Window as Image
This option creates a bitmap image of the active window and copies it to the clipboard.

1. Use the Ctrl-C keyboard shortcut (Windows)/Command-C (Mac) or click Copy
Window on the File or Home ribbons.

2. Paste into a third-party program such as Word, PowerPoint or image processing
package using right-mouse click + Paste or Ctrl-V (Windows)/Command-V (Mac).

Selected plots such as scatterplots, scatterplot matrix, variable maps and line
plots have a Copy Window button on their toolbar to copy the window at high
resolution for large scale plotting, e.g. at A1 or A0 size.

Copy Plot as Image
1. Right-mouse click in an individual plot window and select from one of the fol-

lowing Copy options. The bitmap copy has a number of screen resolutions. The lar-
ger the resolution the larger the resulting image which is created.

2. Paste into third party program such as Word, PowerPoint or image processing
package using right-mouse click + Paste or Ctrl-V (Windows)/Command-V(Mac).

It is also possible to copy windows in EMF (Enhanced Metafile format) and EPS
(Encapsulated Post Script format). These are both vector based file formats that
enable the image to be re-sized while retaining resolution and editing of the
individual map components in other programs such as Corel Draw, Paint Shop,
PowerPoint and Word.

Save Plot as Vector File
1. Right-mouse click in the graph window and select from one of the following Save

options.

2. Enter a name and location for the saved file.
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The EPS (Encapsulated Post Script), EMF (Enhanced Metafile) and SVG (Scalable
Vector Graphics) are all vector based file formats that enable the image to be re-
sized while retaining resolution and editing of the individual map components in
other programs such as Corel Draw, Paint Shop, PowerPoint and Word.

Export Data

1. Go to the File ribbon to see options available in the Export band. Under All ,
choose Export (All Rows) or Export (Visible Rows).

ioGAS™ can export data in the following formats:
l Excel Spreadsheet File

l CSV Text File

l Tab Separated Text File

l Google Earth KMZ File (as Attribute Map)

l AutoCad DXF File

All Rows will export all the rows in the dataset whereas Visible Rows will only
export data that is set as visible in the Attribute Manager. The Visible Row export
option is good to use when you need to sub-set data into a separate file.

The Selected option will export only the columns flagged as special in the
Column Properties dialog plus the columns selected in the Select Variables
dialog. Options to export all rows and visible rows are available from the drop-
down menu.

Print
To print an individual graph directly from a plot window right-mouse click and select
Print from the pop-up menu.
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17. GIS Options

Google Earth
Attribute Maps and Variable Maps can be exported to Google Earth. When the Attribute
Map is exported to Google Earth, the shape, colour and size attributes are rendered
correctly. Variable Maps can also be exported into Google Earth, and like in ioGAS™
their colour and size are retained.

To export into Google Earth, the dataset must contain coordinates for each data point
in Lat/Long WGS84 projection and these columns must be selected as the WGS84
Longitude and WGS84 Latitude columns in the Column Properties dialog (see Step 3).
If the dataset only contains a projected coordinate system, it is possible to generate
WGS84 coordinates using theWGS84 Long/Lat tool in ioGAS™.

1. To export to Google Earth use on the Attribute Map or Variable Map toolbars.

Attribute maps can also be exported to Google Earth via Google Earth on the

Attribute Map Export band on the Map ribbon or from the All or Selected
options on the Export band of the File ribbon.

The colour, shape and size attributes are displayed in a pop-up window in Google Earth
along with selected variable values and Sample ID. Other data may be displayed if it
has been selected in the Select Labels.
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ArcGIS Pro
Users of ESRI 64-bit ArcGIS Pro can import ioGAS™ attributed data using the ioGAS™
for ArcGIS Pro plugin available for download from our website.

See ioGAS™ for ArcGIS Pro for more information.

QGIS
Users of QGIS can import ioGAS™ attributed data using the ioGAS™ for QGIS plugin
available for download from our website.

See ioGAS™ for QGIS for more information.

MapInfo
This option saves an Attribute Map or Variable Map including any colour, shape, size
and visibility attributes and exports them to a MapInfo TAB file. The associated legend
window is exported as a separate MapInfo TAB file as well. The Export to MapInfo
utility is available in both the ioGAS™ 32 and 64-bit versions.

1. In the Column Properties dialog make sure that the East/North Projection is selec-
ted to match the coordinates in the selected East and North columns. If a non-
earth projection is selected the data can still be opened in MapInfo but not over-
lain with other projected datasets.

2. To export to MapInfo use on the Attribute Map or Variable Map toolbars.

Attribute maps can also be exported to MapInfo via MapInfo on the
Attribute Map Export band on theMap ribbon

3. Assign a name and location for the MapInfo file and click Export.

4. Open MapInfo, browse to the Tab file and open.

The colour, shape and size attributes are exported along with selected variable values
coordinate columns and Sample ID.

ioGAS™ attributed data can also be imported into MapInfo using the
Datamine Discover Import Utility.

http://reflexnow.com/iogas/
http://reflexnow.com/iogas/
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Datamine Discover Import Utility
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18. Additional XY Scatter Plot Tools
Now that you are familiar with opening up data into ioGAS™ and doing some of the
basic workflows here are some additional tools available from the XY and diagram
toolbars to investigate further:

Mineral and rock nodes
Individual or groups of minerals or rocks can be plotted as nodes using the following
toolbar buttons:

Show mineral and rock nodes - Cycle through available mineral or rock node
displays or right-mouse click and choose mode - node, node lines, node names
or node formulae.

Mineral and rock node settings - Select the mineral or rock nodes to display.

In order to display mineral or rock nodes on a plot, the variables used as the plot or
diagram axes must be "aliased" in the Column Properties dialog. Mineral nodes can be
projected regardless of oxide/element/unit of the geochemical variables displayed as
the plot axes, even if the plot has calculated axes (including PCA). The currently
selected mineral and rock nodes can be displayed on multiple plots and the current
selection saved between work sessions.

Use the settings dialog to select the mineral and rock nodes and the show mineral and
rock nodes button to display the nodes.

Point density grids
A point density display is a grid of the density of the data points within a graph to
make it easier to visually determine where most of the data is concentrated.

Use the settings dialog to set up the point density grid parameters and the point
density opacity button to display the grid.

Point density opacity - Cycle through available point density opacity settings or
right mouse-click and choose mode.

Point density settings - Modify Point Density Grid Settings.
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Mean/median crosses
Display mean and median crosses for entire dataset or colour group on selected plots
and diagrams.

Show means - Cycle through displaying location of mean for entire dataset or
visible groups using solid cross symbol or right-mouse click and choose mode.

Change mean crosshair size - only active when mean crosses displayed on
plots. Cycle through displaying mean crosshairs sized by 1 x standard deviation
or 2 x standard deviations or right-mouse click and choose mode.

Show medians - Cycle through displaying location of median for entire dataset
or visible groups using dashed cross symbol or right-mouse click and choose
mode.

Regression & Y = X lines
Two types of regression methods are available in ioGAS™: ordinary least squares (OLS)
and reduced major axis (RMA). The OLS method can also be forced to display through
the origin (RTO).

Show regression line - Cycle through colour group and/or all data regression line
display or right mouse-click and choose mode.
Place the cursor over a regression line to view the m (gradient), c (intercept) and
r2 values in a tooltip.

Change regression type - Cycle through least squares regression, regression
through the origin (RTO) and reduced major axis (RMA) regression or right
mouse-click and choose mode.

Show line y = x - Toggle to display Y = X trend line in plot window for entire
dataset.

Mahalanobis Contour Ellipses
Classical and robust M-Dist ellipses can be displayed quickly on XY and SPLOM
(scatterplot matrix) plots by using two options on the XY toolbar. The parameters used
to display the M-dist ellipses are the same as the default input parameters for the M-
dist methods available via the Analysis menu:
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l Classical M-dist

l Robust M-dist (M-estimation) - ellipses calculated using Medium outlier rejection
algorithm

l Robust M-dist (Fast MCD)

The ellipses may be displayed for all data, each colour group or both with four chi-
squared cut-off values: p = 0.5, 0.95, 0.975 and 0.99 available.

Show Mahalanobis contour ellipses - Cycle through p = 0.5, 0.95, 0.975 and 0.99
Mahalanobis ellipses or right mouse-click and choose mode.

Show robust Mahalanobis contour ellipses - Cycle through p = 0.5, 0.95, 0.975
and 0.99 Robust Mahalanobis ellipses or right mouse-click and choose mode:
The ellipses are calculated using the M-Estimation or Fast MCD robust
algorithm. To set the algorithm to use see Calculate Mahalanobis Distance.

M-dist ellipse display mode - Cycle through to show M-dist ellipses by colour
group, by colour group + entire dataset and entire dataset or right mouse-click
and choose mode.
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19. Drillhole and Structural Data
ioGAS™ contains specialised tools for working with drillhole and structural data.

Drillhole Data
For examples of the following tools in action in ioGAS™ go to Open>Open Demo Data
on any ribbon and select Open Drillhole Demo Data.
Attribute Map 3D
Select Attribute Map 3D on the Home or Map ribbon to display drillhole data using
geographical XYZ coordinates in a 3D plot window. Individual data points can be
attributed with up to three variables using colour/shape/size using the Attribute
Manager and rotated to view their distribution within the dataset. Areas of interest can
be isolated using visibility or filter controls. The 3D Attribute Map window updates
dynamically like any other ioGAS™ plot window and data can be selected and attributed
for closer analysis.

The dataset must contain east (X), north (Y) and elevation (Z) data columns which are
mapped to East, North and Elevation in the Column Properties dialog.
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Downhole Plots
Select Downhole on the Home or Graph ribbon to generate a downhole plot, or visual
representation of drill hole data plotted on a vertical axis. Create individual plots using
Hole ID and depth from/to or RL/elevation data.

Three downhole plot types are available. The multi-trace downhole plot can display up
to 8 selected variable traces for one drillhole along its axis. Alternatively, each selected
variable or group can be displayed in a single downhole plot. The distance along the
axis of the downhole plot represents the distance in specified interval units. The traces
on the plot are visual representation of numeric values of the selected variables.

Downhole plot axes can be logged, zoomed and show common or individual axis
scaling. Data points can display the current colour, shape, size and visibility and can be
selected and attributed in the same way as in other plot windows. The colour bar
alongside each downhole plot represents the current colour groups as set in the
Attribute Manager.
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Structural Data
For examples of the structural tools in action in ioGAS™ go to Open>Open Demo Data
on any ribbon and select Open Stereonet Demo Data.

Select Stereonet on the Structure ribbon to generate a stereonet using Dip and
Azimuth (Dip Direction) measurements. A Stereonet is a graphical representation of 3D
structural data on a 2D surface and is used to analyse the angular relationships
between lines and planes in 3D space. The stereonet plotting functionality in ioGAS™
includes the ability to plot lineations and planes, determine means per colour group,
calculate beta axes, change plot projection on-the-fly and produce in-built calculated
statistical reports.

Other structural tools available include alpha/beta/gamma structural data conversion
and rose plots.
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20. Multivariate Analysis Tools
Many of the analysis tools within ioGAS™ are located on the Analysis ribbon and are
grouped into the following bands:

l Statistics

l Transformation

l Outlier Analysis

l Classify

We visited some of the more simple statistical tools during this tutorial however some
of the more advanced tools require a deeper understanding of the underlying theory
behind multivariate analysis before they should be used. A summary of the available
analysis tools is provided below:

Statistics Band

Summary Statistics

Generate summary statistics for all variable columns as designated in the Select
Variables dialog. Summary Statistics include count null, count zero, maximum,
minimum, range, mean, median, percentile values plus many others. Statistics selected
for display is fully customisable. Under the Summary Stats drop-down menu is the
following option:

Summary Statistics (Special Columns)

Generate summary statistics for all special columns as designated in the
Column Properties dialog. Special columns include Sample ID and
coordinate columns.

Frequency Table

Frequency table indicates how many samples fall into each individual category or
numeric value within the selected variable columns. Under the Frequency Table drop-
down menu is the following option:

Frequency Table (All Columns)

Display frequency tables for all of the columns in the dataset.
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CrossTab

Create a CrossTab table to show the count, mean, median, standard deviation,
coefficient offset, minimum and maximum values for the selected numeric variables
based on two categorising variables.

Correlation Matrix

Display the correlation coefficient for each pair of selected variables. Results can be
calculated using classic Pearson or Spearman Ranked methods.

Regression

Regression analysis is used to determine the linear equation (s) that model the
relationship between response and explanatory variables. Simple and multiple
regression analysis are both available as well as a robust option to down-weight
outlying data points.

Transform Band

Centred Log Ratio

Centred Log Ratio (CLR) transformation is used for "opening" constant sum data.
Geochemical data sum to a constant (100% of mass) producing closure effects in data
that may lead to induced correlations. The CLR transformation ‘opens’ the data and
can be helpful for removing spurious correlations. This is especially the case with major
element data.

Make Levelled Columns

Apply levelling operations (mean, median, Z-Score, etc) on selected data columns to
distinguish anomalous values within datasets that contain multiple populations, e.g.
different rock types, regolith units, mesh sizes, laboratory analysis methods, etc.

Weighted Sums

Weighted Sums is a simple multivariate technique used to reduce several variables to
one variable where there is prior knowledge about the underlying processes. Each
variable is assigned an importance value which is then normalised to make 'weights' so
that the sums of the squares of the applied weights is 1.
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Outlier Analysis Band

Auto-Attribute Tukey Outliers

Run a Tukey box plot algorithm and assign size and shape attributes to outlier samples
that plot outside the main Tukey plot fence so they can be identified in other plots.
Under the Tukey Outliers drop-down menu is the following option:

Auto-Attribute Tukey Outliers (Logged)

Run a Tukey box plot algorithm on log-transformed data and assign size
and shape attributes to outlier samples that plot outside the main Tukey
plot fence as they can be identified in other plots.

M-Dist (Compute Mahalanobis Distances )

Mahalanobis Distance (M-dist) is a multivariate analysis technique based on the
means and variances of selected variables and on the covariances between each pair of
variables. It is used to determine how far a sample value "lies" from the central
tendency of a data group. Two robust M-dist algorithms are available in which "outlier"
samples have reduced impact on the overall Mahalanobis distance calculations by
assigning them less weighting. Under the M-Dist drop-down menu are the following
options:

Classical

Standard M-dist calculation devised by P.C. Mahalanobis.

Robust (M-Estimation)

Robust variation of M-dist calculation based on the algorithm devised by
N.A. Campbell.

Robust (Fast MCD)

Robust variation of M-dist calculation based on the algorithm devised by
P.J. Rousseeuw and K. Van Driessen.

Distance-Distance Plot

Scatter plot of classical M-dist values vs robust Fast MCD M-dist values.
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Set Robust M-Dist Algorithm

Choose robust algorithm to use in the Anomaly Assessment Tool and when
displaying robust M-dist ellipses on scatter plots.

Anomaly Assessment Tool

Identify outliers or atypical samples within domain classified data using a combination
of univariate test (Tukey plots) to isolate near and/or far outlier samples and
multivariate test (robust variant of Mahalanobis Distance) to examine variable
correlations within each domain.

Classify Band

RGB Zonation

Select three variables and set absolute value or percentile thresholds and then apply a
colour RGB thematic to the data points according to how its values compare to the
threshold value. For example, all samples which have values greater than the 80th
percentile for the selected variables Cu, Au and Mo are coloured grey, whereas a sample
which only has a Cu value greater than the 80th percentile is coloured blue.

DPA (Discriminant Projection Analysis)

Discriminant Projection Analysis (DPA) emphasises the projection component of
discriminant analysis to produce visual outputs for exploratory data analysis. Samples
are projected into a lower dimensional space to best show the separation between
groups graphically. There are two steps involved in DPA: the 'projection step' and if
required, the 'classification step'. DPA may also be used as an exploratory technique to
indicate which of the selected variables are most important for determining maximum
group separation. Under the DPA drop-down menu is the following option:

Variance Importance Plot

Find the subsets of input variables that best discriminate colour groups
under DPA.

Auto-Domain

Automatically create a classification diagram from data groups. These groups could be
a priori knowledge or generated from the K-means clustering or Discriminant Projection
Analysis tools. Group boundaries are created using Mahalanobis Distance calculations.
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PCA (Principal Component Analysis )

Principal Component Analysis (PCA) is a multivariate statistical technique used to
reduce the dimensionality of data so as to maximise the variance. PCA finds the best
set of linear equations to use to reduce the number of variables that are needed to
describe a dataset. Reducing multivariate data to 2 or 3 derived variables enables it to
be more readily visualised. Under the PCA drop-down menu are the following options:

Classical

Standard PCA calculation.

Robust (M-Estimation)

Robust variation of PCA calculation based on the algorithm devised by N.A.
Campbell.

Robust (Fast MCD)

Robust variation of M-dist calculation based on the algorithm devised by
P.J. Rousseeuw and K. Van Driessen.

Biplot

Two dimensional plot showing combinations of principal components 1 to 4
and original variables as vectors.

3D Biplot

Three dimensional plot showing principal components 1 to 3 and original
variables as vectors.

SOM

Self-organising map (SOM) is an unsupervised training algorithm using neural networks
to produce rapid classification of groups within a dataset. Under the SOM drop-down
menu are the following options:

Create New SOM

Generate a new self organising map.

User

Library of user created SOMs.
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Open Other SOM

Browse to the location of the SOM *.XML file to open.

Recent

List of recently opened SOMs.

Clustering

Apache K-means unsupervised clustering algorithm to partition a population of data
into smaller sub- populations. Use to interrogate the grouping structure between
variables and to prepare the dataset for further interpretation.

Wavelet Tessellation

Wavelet Tessellation is two analytical approaches to processing complex signals
integrated together into one workflow. A wavelet transform is a process of performing
multi-scale edge detection on a signal such as gamma or geochemical variable, while
the wavelet tessellation turns the signal into an interpretable pattern that can be
related to the geology.

Support
New single seat (perpetual) licences include 12 months technical support but ongoing
maintenance must be purchased after this time in order to continue to receive technical
support. Server and single seat (12 month) licences automatically include technical
support in the purchase price.

Maintained clients can lodge support issues through the IMDEX Customer Care Portal.
The portal can also be used to track and manage support queries, request
enhancements and access knowledge base articles.

You will need to register in order to use the Customer Care
Portal.

Alternatively, contact us via email at iogas.support@imdexlimited.com.

http://support.imdexlimited.com/
mailto:iogas.support@imdexlimited.com
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Where possible include a screen capture of the Help>About information and a copy of
the log.txt files located in the C:\Users\Username \AppData\Roaming\ ioGAS™\log
folder (Windows) or the Applications\ ioGAS™ \Contents\Resources\app\log folder
(Mac). Note Username = your login name.

The log files can also be accessed using the Browse to Logs button on the Help ribbon.
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